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Introduction

Components

g

.

SoundSens i correlation pods
SoundSens i carry case
Software CD

Mains charger

Download leads

(1 x Serial, 1 x USB)

Concept

The SoundSens i system comprises a powerful software package and the SoundSens i
pods which can be setup in the field with or without a PC. Recordings can be stored in the
memory of the pod, or the unit can be used with a PC to correlate in the field as a
multipoint unit carrying out the test straight away or as a delayed test i.e.: overnight.

SoundSens i can store four sets of recording sessions. This is equivalent to 4 nights of

data storage. The SoundSens PC software contains help files for using the PC to setup,
download and analyse recordings.

This manual was written using Radcom SoundSens software version 3.2.1 and HWM SoundSens i sensors.

SoundSens i User Guide
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Charging the Carry Case

The carry case contains rechargeable batteries. It must be charged for 24 hours before
first use. Re-charge the carry case when the battery status LED starts to flash RED. The
data will be lost if the unit goes completely flat. However, the battery low LED will give
plenty of notice of a low battery (i.e. days) and should be seen as an indication to
download data and re-charge.

The charge in the carry case battery pack should last approximately two months
depending on how frequently it is used.

To charge the batteries plug the supplied mains charger into the charging socket next to
the battery status LED. While charging the LED will flash ORANGE.

When the batteries are charged the battery status LED will flash GREEN (even if the
charger is still connected).

SoundSens i User Guide
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Setting Up SoundSens
Setup With PC

Start the software

Sound Recorder

S .
Run the SoundSens software from the Windows Start menu
{8 setings as illustrated here.
@ Skype for Business
E:}o Snipping Tool

SoundSens

R
WY Language Selector

‘:] readme

. SoundSens

Sticky Notes

T

I"’I TeamViewer

== L search - e

Radcom SoundSens - Untitled
e Gomns Corvelstin Yew [odk bbb

¢ % 128 =B | Ba | KLY

SoundSens oz .
-« @l The opening screen for the SoundSens

Tamcs | Sewch Reats |
software.

lafthoss leaks using carlal
[The Leak noise data (= stared by e
|Sound8ens softwars onto the PC's intemal
[Fara Drve or can 0g Storen acrss 3
IMetwark o 3 File Server.

(Carralstion anahsic tan be undetaken On
site' on P,

[ThE iniial S131e of e Nelp bar may
Jcanfiaured in e ‘Starus” cations. found an_ %
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Connect the carry case to the PC

Serial (RS232) Communication Cable

The male end of the cable plugs into the Master
Serial connector on the carry case, and the female
end plugs into your laptop or PC.

See next page for further information

v

MASTER USE SLAVE
SERIAL SERIAL
l | | ||
Ol | O o [ O
| |

USB Communication Cable

The A end (rectangle shape) plugs into your PC or
laptop, and the B end (square shape) plugs into the
USB connector on the carry case.

Found New USB Device

This message will appear indicating the

sensor Type [Production Sensor I = software has detected the case
Pork: |%" Sound3ens i USE Bridge Controller (COMS) j
Enin See next page for further information

SoundSens i User Guide
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Information regarding connection via Serial RS232

When you connect the carry case to your laptop or PC via the Serial (RS232) cable the PC
will not do anything. You must select the correct communications port manually.

W IE! Window  Help
il

Cpkions. .,

From the Tools menu click Options

Irmport...

Export...

Import Pipe Layout...
Export Pipe Layout. ..
Edit Pipe Layout Id's, ..

Then select the Communications tab (see below)

— L

Options...

; Communications - Select the comm part ko use to connect the soundens suitcasze to &
e the PC. Uze 'Help - Find Available Ports' for more information on awvailable ports. B
Feersrea gy Cancel

Recording Defaults | Pipe La_l,u:uut] Eu:urrelatiu:un] Exhaustive Eu:urrelatiu:un] E "l

Production Sensor 1 ;I\\
COw5e /_v]:)

[v Manitor USE Paortz. Prompt when USE device connection changes

Synchronization Canfirmation
[v Prompt on detailed setup

[ Prompt on quick setup

Help - Find Available Parts...

Select the correct port from the drop down list.

For extra help please see page 54 or contact the HWM technical support team.

SoundSens i User Guide
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Information regarding connection via USB

With the software started connect the SoundSens carry case to the PC using the USB
communication cable.

This message will appear indicating the

Found New USB Device 4] software has detected the case.
Sensar Type |Pr0ducti0n Sensor I1T j
Part: |9&9 SoundSens i USE Bridge Contraller (COMS) j

Select | Cancel |

On the Sensor Type drop down menu you can select the following

Found New USB Device

Sensor Type |Pr0ducti0n Sensor 11T ﬂ

Pre-Production Sensor —_|
Production Sensar M3 T
Production Sensor 1T
Production Sensor 111

Part:

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor IIl (Otherwise known as SoundSens i)

The port drop down menu is usually picked automatically.

Found New LISB Device

=l
Fort: |¢& Sound3ens | USE Bridge Controller (COMS) j
&7 Comt ~

COMz2 —

&5 CoM3
COM4

Sensor Type |Production Sensor 111

SoundSens i USE Bridge Controller 5)
COMe bt

Found Mew LISB Device i .
Click Select to continue.

Sensor Type |Producti0n Sensor 111 ﬂ

Fort: €& CP2103 USE to LART Bridge Controller (COMS) |

Cancel |

SoundSens i User Guide
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Information regarding daisy chaining multiple cases together

To communicate with multiple cases you need to connect them together using SoundSens
serial communication cables, and then via USB to the PC.

The suitcase lid will have an arrangement of D shape communication ports and a USB
port.

There are variations on the lid as shown below.

OK  CANCEL MODIFY OK  CANCEL MODIFY
T T , } N . .
| OO0 OO0
v X = v, X =
MASTER SLAVE
SERIAL use SERIAL TO UsB TO
. . MASTER SLAVE
e I'- |'I o =} ] o [~
\ ] | | [ I: II |8 ) |
E ad ; nad B MASTER SLAVE SLAWE
a usa 15 g USE 15 g USE
O ? ’ o 49
o I 1 | L |

In all situations you need to daisy chain the cases as shown below.

MASTER SLAVE SLAVE
9 s 1S 5 usé 15 g USE 15

O R W W O w | WO Y

Note: You can not chain together 4 pod kits, but one 4 pod kit can be connected to the end
of a chain of 8 or 6 pod kits.

SoundSens i User Guide
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HWM

Communication Test

With the carry case (or cases)
connected to your PC or Laptop
click the sixth icon on the menu

4 bar.

The software will now communicate
with the case (or cases) and
loggers.

5 Radcom SoundSens - Untitled

Eile Comms Correlation  Mew Tools

Mindow  Help

0| & W Q2
Wizard Bar R3] untitled

| o | | - SoundSens Organiser
User, Defined Logger Parameters |

Position | Suitcaze Mumber | User Defined ID | Site Info

The list which pops up shows the

ro ) ===1 logger positions in the case. If_any
3 vz e | loggers have failed to communicate
5 e S they will be missing from this list.

7 1 76 Site Info

3 1 T

Click Ok.

REMEMBER TO SAVE REGULARLY

wizand Bar x S El rgl

D New CIICk Save Type a n_a.me Save jn |@50und5&ns j ef BB
. for your flle [ 07_07_03_10_09_18.ssd
= Open \_\5 B 07_n7 _na_t0_13_a4.55d
Brlgiﬁc;ﬂr& 07_07_03_15_46_04.s5d
1 Recording Setup Make Sure the @ E::g;:ngij‘::ggz:
; file name has e - oy
Create Pipe Layouwt} /| 0 N |meT e =
— not been used Kty _
3 Download before. NS Click Save
4 Corelate
é My Computer
Save 6 r—
st Ecrirfoge M};ﬁnfk File name: ‘Soundﬁ ens Tesf ﬂ 5\343
= Save as lype | SoundSens Document” ssd) | Cancel
You will only be prompted to type a file name if you have not clicked
save before.

Every other time you click save the updates will be saved but no
other action will be required.

SoundSens i User Guide
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Quick recording setup

‘wizard Bar x| File Comms Correlation Wiew Tools windo

D New 1 ¥ W
“wizard Bar

= Opel‘l -)- SoundSens Crganiser
O New Pipe Layout

Recordings

1 Recording Setup

= Open

2 Create Pipe Layout

3 Download 1 Recording Setup

4 Comelate
Save Connect the carry case to your PC or Laptop.
Sawe After Each Stage To setup a quick recording either click the Recording Setup button on
the Wizard Bar (left image), or click the 7™ button on the menu bar
(circled above).
Quick Recording Series Setup le
. 1E;g|g;4nl4:1ln:n4 l4:2|5:14 14:4!3:24 14:5|5:34 15:1|D:44 ThIS IS the QUICk Recordlng Serles Setup

e window which will pop up after clicking the
tart Series .
|:§ @ &k Time/Date  |03/07/2007 w| [141000 = Recordlng Setup button.

Wit Cancel i i i i . .
o Potod oo Quick recording setup is explained in detail
ample Fenod [ econds,

B Smal Dismeter Metal (10] next.
-
" Large Diameter Metal [20]
" Plastic [30)
™ User Defined

-
Mumber of Recordings 3 _|:I

ek Recording Interval 16 Mirutes «
temony Uzage: m

SoundSens i User Guide
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| The time line shows a series of logging

s S€Ssions as dark blue lines. (SEE
DIAGRAM BELOW)

If the time line is red then check the

Start Series

14:10:04 14:25:14 14:40:24 145534
140240
142306 14:38:16 14:53:26

E@ & At Time/Date |IZI3£EI?£2IZIEI? j |14:1n:nn

" Wit

Start Series

E@ At Time/Date |

[

* Wait 115 Minutes = |

15 Minutes
20 Minutes
25 Minutes
30 Minutes

35 Minutes
40 Minutes
45 Minuteg %

.. otart Series At Time/Date” values are
not in the past (SEE NEXT DIAGRAM).

It is possible to set a date and time for the
recording series to start

NOTE : Do not set a start time more than 36
hours in the future.

Alternativly you can set the loggers to wait for
a period of time before starting.

You can set the waiting time between 1
minute and 3 hours.

Make sure you have sufficient time to deploy
the pods before the run starts!

I ey I My I oy
Facording 1 | | Racording 2 | I Racording 3 |
| — P
Vel Recording Fecording
i Time Ierval Interval
Hiesy Tiema

Black line
indicates the time
now

=

First light blue
space is Wait time

F

Dark blue lines are
recording times

Quick Recording ‘ieries Setup

IR

At Time/D ate:

Sample Period [zecondz]
| & Small Diameter Metal [10]
" Large Diameter Metal (20)

" Plastic [30]

" User Defined

temary Usage:

. Recording Interval

14:25:14 14:40:24 14:55:34 151044

|0330?;200? j |14;1n:nn =
Cancel

Mumber of Recordings:

==l
5 =
15 Minutes =

SoundSens i User Guide
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Sample Period [seconds] Select the sample period.
B & Small Diameter Metal (10) This is determined by the pipe material and
- .
(" Large Diameter Metal [20] diameter.
" Plastic [30]
¢ User Defined = Suggested sample periods for pipe materials
and lengths are shown below.
Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4’MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

NOTE : On sites with mixed pipe material always select the longest sample period. So if
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds.

Number of Fiecordings 5 4 Set the number of recordings
Riecording Interval (16 Minutes ] (max 9), and set the recording interval

Memory Usage: m (between 1 minute and 3 hours)

The recording interval is the gap between the START times of each recording.

e.g. if three recordings of 1 minute each are set to start at 1AM with a recording interval of
1 hour then the start times will be 1am, 2am, 3am. If the recording interval is 15 minutes
then the start times will be 1am, 1:15am and 1:30 am.

HWM recommends 3 recordings — see explanation below.

The recording interval needs to be set with local knowledge in mind. Think of how long it
takes for a toilet to fill in your local area, and set the recording interval to that time. This
will help reduce the detection of noise which is due to legitimate consumption.

This is also partly the reason why we suggest 3 recordings. If a logger detects a noise
which can be put down to legitimate usage then hopefully on the second or third recording
the usage will have stopped.

Humber of Recordings U Some combinations of sample periods and
. Recording Interval 15Mines  ~|  NuMber of recordings will cause excess
memory usage. This is due to memory size
restrictions in the logger.

Memmon Uzage:

SoundSens i User Guide
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m SoundSens i User Guide

Leak Localisation and correlation

Quick Recording Series Setup 3] After you are happy with the settings in
| | | | | | the setup window, click OK.
. 14:10:04 14:25:14 144024 14:55:24 15:10:44
14:02:40
Start Series — -
ak.
[of © 4t Time/Date |Da/7s007 - | {14000 ‘!'
" whait Cancel

Sample Period [zeconds)

|+ Small Diameter Metal [10]
(" Large Diameter Metal [20)
" Plastic [30]
" User Defined

=
Mumber of Recordings 5 _%I

55 Recarding Interval 15 Minutes =
temary Usage: m

The SoundSens software should
communicate with the suitcase.

. 15:46:02 15:48:12 15:50:22 15:52:32 15:54:47

15:43:58

Start Senies
E,, _~
8 ~°

oK

=

Imitializing Suitcase

E
-
_E

Eztimated Time Remaining: 0 min 12 zec

" User Defined | j

Murnber of Fecordings 5 _%I
Recording Interval 2 Minutes -
Memaory Usage: m

SoundSens [Z|
The SoundSens software will display this message if the

1) Upload Completed Successfully, | SEUP worked. Click OK to continue.

Deploy SoundSens i correlation pods ( i.e. loggers) on site.

You should have sufficient time to deploy the pods before the run starts.

As you deploy make a note of the SERIAL NUMBER of the Pod and its location on site.
CONTINUED...

SoundSens i User Guide
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Quick recording setup with Multiple Cases

Connect the suitcases together as shown in the section “Information regarding daisy
chaining multiple cases together”

Follow the instructions from the section “Quick recording setup”.

At the stage of upload you will notice the software communicates with each suitcase and
each logger within in turn.

SoundSens i User Guide
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After uploading the settings to the loggers the SoundSens software will look something like
this...

8 Radcom SoundSens - [Pipe Layout]

E] File Comms Correlation Wiew Tools Window Help E |:|'|
0| @ | |8 % 580 X4 5| 00:00:33 (1)
‘wizard Bar X éé,f ’%iﬁ| @J %| SoundSenS Eﬂ

O N ew B ¢ oo |
— || Topics ] Search Results |
Introduction ”~
=3 Open Getting Started _
“wizard Bar

Connecting the Hardware

1 Recording Setup Corfiguring a Recording

Introduction 4

2 Create Pipe Layout SoundSens is a powerful software package
used with SoundSens CP (Correlation Pod) —
Loggers to identify the presence of leaks in
pipe work and determine the actual position
3 Download ofthose leaks using carrelation technigues.
The Leak noise data is stored hy the
SoundSens software onto the PC's internal
. Hard Drive ar can be stored across a

4 Ccorrelate Metwark to a File Server.

Carrelation analysis can be undertaken 'On
site'with a Lap Top PC, or can be
downloaded from the Correlating Pods ata

o7
ater time. Furthermare the collected data
SaVE laterti Furth th llected dat:
can be re-analysed from the files stored on
Save After Each Stage the PC's hard drive aorfile server with

alternative filter settings and correlation
processors if required.

Getting Started

This help bar may be increased in size by
dragging its left side, or made full size with
the maximise button.

It may be remaoved fram the display with its
Close button, or via the Wiew' Menu option.
The Wiew' menu may also be used to

M| |display the bar after it has been removed.

> The initial state ofthe help bar may be

< |
B # || [zonfigured in the 'Startup’ options, found on
% &@ A . . . — | [the options 'General' page {Tools' menu,

. . 'Dptions...".
Fipe Join Tesxt Comment R aTeh 3726 v

Awizard bar is orovided to auide vou

SoundSens i User Guide
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Setup Without PC

Basic Carry Case Operation

Please note

When the carry case is not being used it will switch to a low power standby mode for
battery conservation, so the carry case display will turn off after 20 seconds if no buttons
are pressed. If you are in the middle of making any changes or setting up a recording
session you will have to start again.

The carry case display can be reactivated by pressing OK, CANCEL, or MODIFY. The
first thing you see on the display will always be the time and date — You must check that
this is correct before setting up a recording. However the chances of the time being
wrong are very small because every time the SoundSens software communicates with the
carry case it will synchronise the time.

In addition to the time/date this screen can also show

e BATTERY LOW (if the battery needs charging)

e BATTERY CHARGING (when the charger is plugged in)

e Recording countdown (time until next recordings starts) if neither of the above apply
and a recording has been set up.

The format for the recording countdown is: HH:MM:SS (N)

HH — Hours

MM  — Minutes

SS —Seconds

N — Number of recordings remaining

Pressing the MODIFY key cycles through the main options.
To select an option press OK.
Pressing CANCEL returns to the time/date screen.

Main options (Press Modify to cycle through):
e Time/Date

e Setrecording 1? (30min delay) — daytime quick recording setup
e Setrecording 2? (2am start) — overnight quick recording setup
e Recording setup? — Custom recording setup

e Download data?

e Stored data

e Set time/date

SoundSens i User Guide
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Set Time / Date

Setting the time is rarely necessary as the unit contains an accurate clock, and when
connected to a PC the time and date are updated.

PwpnPE

Recording options

There are three options for setting up a new recording.

1. Daytime Quick Recording

2. Overnight Quick Recording

3. Custom Recording

Press MODIFY to cycle through the menu options until you see “Set Time / Date”
Press OK to enter edit mode

Use the MODIFY key to change the value
Press OK to move to the next value

This table should assist you in deciding weather one of the pre-programmed sessions will

be suitable, or if you need to set up a custom recording.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8" +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

SoundSens i User Guide
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Daytime Quick Recording Setup

This sets up a recording session which will start after a 30 minute delay. Three recordings
will be made each 20 seconds long, five minutes apatrt.

Delay to start of recording: 30 min
Interval between recordings: 5 min
Length or each recording: 20 sec
Number of recordings: 3

Check the table at the bottom of this page to see if it is suitable for your test.

1. Press MODIFY to cycle through the menu options until you see “Set recording 1”
2. Press OK to setup the quick recording

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.

When the recording setup is complete the screen will show a confirmation message, e.g.

4 LOGGERS -0—
PROGRAMMED -000

The number of loggers programmed is displayed, and the right side of the screen shows a
map of the positions of the programmed pods (‘O’ represents a logger present and a ‘-
shows a vacant position). If this differs from the actual positions of the loggers below the
most likely explanation is that the windows on top of the pods are dirty or that an object is
on top of the loggers.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8" +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+
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Overnight Quick Recording Setup

This sets up a recording session which will start at 2am. Three recordings will be made
each 20 seconds long, one hour apart.

Recording start time: 2 am
Interval between recordings: 1 hour
Length or each recording: 20 sec
Number of recordings: 3

Check the table at the bottom of this page to see if it is suitable for your test.

1. Press MODIFY to cycle through the menu options until you see “Set recording 2”
2. Press OK to start the recording setup

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.

When the recording setup is complete the screen will show a confirmation message, e.g.

4 LOGGERS -0—
PROGRAMMED -000

The number of loggers programmed is displayed, and the right side of the screen shows a
map of the positions of the programmed pods (‘O’ represents a logger present and a *-*
shows a vacant position). If this differs from the actual positions of the loggers below the
most likely explanation is that the windows on top of the pods are dirty or that an object is
on top of the loggers.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8" +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+
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Custom Recording Setup

This option sets up a recording with user-defined settings.

Press MODIFY to cycle through the menu options until you see “Recording Setup”
Press OK to start

For each setting number use the MODIFY key to change the value

Press OK to move to the next setting

PwbdPE

The options available are:

1. Recording Start Delay
e 1,510,15,30 or 60 minutes
e At the beginning of an hour (press modify to cycle through)

2. Length Of Each Recording
e 10, 20, 30 or 60 seconds

3. Recording Interval (time between recordings)
e 1,2,5,10,15, 20, 30, 45 or 60 minutes

4. Number Of Recordings
e 10, 20, 30 or 60 seconds

This table should assist in selecting the recording options you need.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4’MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

NOTE : On sites with mixed pipe material always select the longest sample period. So if
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds.

The recording interval needs to be set with local knowledge in mind. Think of how long it
takes for a toilet to fill in your local area, and set the recording interval to that time. This
will help reduce the detection of noise which is due to legitimate consumption.

This is also partly the reason why we suggest 3 recordings. If a logger detects a noise
which can be put down to legitimate usage then hopefully on the second or third recording
the usage will have stopped.

Continued...

SoundSens i User Guide
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For the last setting, ‘number of recordings’, if a value is selected that uses more than the
available memory in the logger then exclamation marks will be shown as a warning. For
example if the recoding length is set to 60 seconds and the number of recordings is set to
4 then the display will show:

NUMBER OF
RECORDINGS:4 !!

The exclamation marks show that the logger memory will overflow if this combination of
settings is used. In this situation, use a lower number of recordings or a shorted recording
time.

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.
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Downloading Data To The Carry Case

Data can be held in the carry case and downloaded to a PC or Laptop at a later stage. To
download data after a recording:

1. Place the pods back into the case (in any order or position) and lower the front
panel.

2. Press MODIFY to cycle through the menu options until you see “Download Data”

3. Press OK to start the download

A message will be displayed during data transfer. After downloading data from the pods a
confirmation message is shown. This is the same format used after setting up a recording
and shows which loggers have transferred data.

DOWNLOAD -
COMPLETE -00-

Viewing Stored Data Details

This option shows a summary of data sets stored in the SoundSens i. A ‘set’ is the
collection of data transferred during a download. The summary shows the set number,
number of pods used and the start time of the first recording, e.g.

SET: 02 PODS: 06
09:50 20/02/07

1. Select the Stored Data? option with MODIFY
2. Press OK to view the summary for the first set
3. Press OK to view the next set

When all sets have been displayed there is an option to delete the last set. Note the
delete operation cannot be undone.

1. Select the Stored Data? option with MODIFY
2. Press OK until all the sets have been seen and the message “Remove last set” is
shown
To delete the data use the MODIFY key to select YES then press OK

Memory Capacity

There is enough memory in the case to hold 4 downloads from 8 SoundSens i correlator
pods which are full of data. When the case and all the pods are full of data you will not be
able to record any more and you will see “Memory Full” on the display. Either download
the data to a PC or erase some data from the View Data menu.

One pod will hold approximately 120 seconds of data.
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SoundSens i Case User Interface

Summary

Press any key to
wake up display.

Time and Date

Time and Date

First screen is always

Press Modify

(—

Set Recording 1?
(30 Min Delay)

Press Modify

(—

Set recording 27?
(2 am Start)

Press OK to select an

Press Modify | item. ,
Further explanation

below.

(—

Recording Setup?
(OK) To Start

Press Modify

(—

Download Data
(OK) To Start

Press Modify

(—

Stored Data
(OK) To View

@ Press Modify

Set Time/Date
(OK) To Start

Pressing Modify
returns to
Time and Date

SoundSens i User Guide
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Set Recording 1 (30 Minute Delay)

Set Recording 1 (30 Min Delay) > press OK

Press any key to wake up display.
Time and Date should be displayed.

A recording session will be set up

with the following settings...
Press MODIFY once

Display should read... 3 Recordings
) 20sec Duration
Set Recording 1? 5 min Intervals

(30 Min Delay)

This is not shown on the display.

ﬂ The display will

show
The number of loggers programmed Setting up
depends on the number of loggers in the recordings
case.
Each 0 shown on the right represents a ﬂ Followed by
logger in the case.
\ 8 Loggers 0000

Programmed 0000

The display will then change to a
countdown timer showing the time until the
recording starts and the number of

recordings left (number in brackets).

v If a recording is taking place
14 :31 04/02/07 then the display will show the
Rec 00:00:00 (3) following message.
Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power. v

14 :31 04/02/07

Wake up the display by pressing any key. It should Recording in progress

show the current recording session countdown time, or
the time and date if recordings have finished.

SoundSens i User Guide
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Set Recording 2 (2am Start)

Set Recording 2 (2 am Start) > press OK

Press any key to wake up display.
Time and Date should be displayed.

A recording session will be set up

) with the following settings...
Press MODIFY twice

Display should read... 3 Recordings

20sec Duration

Set recording 27? 1 hour Intervals

(2 am Start)

This is not shown on the display.

ﬂ The display will

show
The number of loggers programmed Setting up
depends on the number of loggers in the recordings
case.
Each 0 shown on the right represents a ﬂ Followed by
logger in the case.
\ 8 Loggers 0000

Programmed 0000

The display will then change to a
countdown timer showing the time until the
recording starts and the number of

recordings left (number in brackets).

v If a recording is taking place
14 :31 04/02/07 then the display will show the
Rec 00:00:00 (3) following message.
Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power. v

14 :31 04/02/07

Wake up the display by pressing any key. It should Recording in progress

show the current recording session countdown time, or
the time and date if recordings have finished.
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Set User Defined Recording

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY three times
Display should read...

Recording Setup?

(OK) To Start

After the loggers have been
programmed the display will change to
a countdown timer showing the time
until the recording starts and the
number of recordings left (number in
brackets).

Press OK
Display will show A

Recording Start
Delay 01Min

Press OK to accept
Display will show

Length of each
Recording

Press OK to accept
Display will show

Recording Interval
Delay 01Min

Press OK to accept
Display will show

Number of
Recording :3

Press OK to accept
Display will show

Setting up
Recording

Followed by

8 Loggers 0000
Programmed 0000

14 :31 04/02/07
Rec 00:00:00 (3)

If a recording is taking place
then the display will show the
following message.

A 4

14 :31 04/02/07
Recording in progress

Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power.

Wake up the display by pressing any key. It should
show the current recording session countdown time, or
the time and date if recordings have finished.

The number of loggers programmed
depends on the number of loggers in the
case.

Each 0 shown on the right represents a

A

logger in the case.
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Download Data From Loggers to Carry Case

Download Data Press OK
Display will show
Press any key to wake up display. :> Downloading From
Time and Date should be displayed. Loggers...
Press MODIFY four times Followed by

Display should read...

Downloading 0000

Download Data Complete 0000
(OK) To Start

The number of loggers downloaded in the case is represented
by a 0 shown on the right hand side of the display.

When the download data option is used, the data is read from
the loggers and held in the memory of the case. It can then be
downloaded to the SoundSens software at a later stage.
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View Stored Data

View Stored Data

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY five times
Display should read...

Stored Data

(OK) To View
Press OK This indicates that the first
Display will show recording in the memory of the

/ case had 8 loggers and was
Set: 01 PODS: 08 recorded on 30/1/07 at 17:09
17:09 30/01/07

Press OK -
Display will show Here_you have the option of
deleting the last recording held

in the case. By default NO is
selected. If you want to delete
the last recording press Modify

Set: 02 PODS: 08
17:49 30/01/07

Press OK
Display will show

Press MODIFY
Display will show

Remove Last Set Remove Last Set
Yes (--No--) :> (--Yes--) No
Press OK

Display will return to Dis;;illsvsv iﬁ)sKhow ﬂ
Stored Data Set
(OK) To View Rem(e)ved

And then the display
will return to

Stored Data
(OK) To View
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Set Time and Data

Set Time and Date

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY six times
Display should read...

Set Time/Date
(OK) To Start

Time and Date
Displayed

Press OK

Set Hour

Press Modify to change value
Then press OK

Set Minutes

Press Modify to change value
Then press OK

Set Day

Press Modify to change value
Then press OK

Set Month

Press Modify to change value
Then press OK

Set Year

Then press OK to set the time.
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Dealing With Data

Creating A Pipe Layout

It is possible to either create a basic schematic layout of the underground pipe work, or
add a background image for illustration purposes.

Pipe Layout Menu

Add map / Move pipe layout items Logger correlation
background image w selection

Cl
Show / Hide pipe layout toolbar Adjust zoom level

SoundSens i User Guide
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Add a background image (optional)
i [
’j&*ﬁ A’ﬁ| %| M| Click the Add Map / Background Image button.

Pipe Layout Backgrond Bitmap Ll Click Browse and use the standard
windows explorer interface to locate a

Fipe Layout Background Bitmap

_ m bitmap (bmp) file to use as a
= Browse.. background.

_ _ You must click the “Display Bitmap” tick
@'SP'E‘P Bitmap box for it to appear on the layout. By

Fipe Layout Background Bitmap default it is not ticked.

+—*

Harizantal 100 % At a later stage you can go back to this

menu and un-tick this option to remove

|:| I Yertical: 100 % the map.

SoundSens software shown below with map background image.

8 Radcom SoundSens - [Pipe Layout]

ﬁj File Comms Correlation Wiew Tools MWindow Help L :"l
0w d & & 4% &4 = |4
wizard B | (ot i
Gl =l | [ 5| 2| ol SoundSens 2=
] NBW d}’?qb S —

% % Topics 1 Search F\esults}

Introduction -
L Getting Starked
Yo 5 “Wizard Bar
2y 4 Connecting the Hardware
*% ad I Configuring & Recording b

& Open %

1 Recording Setup

Introduction &

2 Create Pipe Layout r,o“’e 2 5 SoundSens iz a powerful software package

o ng" usedwith SoundSens CP (Correlation Pod)

& Laggers to identify the presence of lzaks in

pipe waork and determine the actual position

3 Download ofthose leaks using correlation technigues.
The Leak noise data is stored by the

SoundSens software onto the PC's internal

o Hard Drive or can be stored across a

4 Conelate Stz ) Metwork to a File Server.

9”% ﬁﬂ‘ Correlation analysis can be undertaken 'On

4"9 é’ M site'with a Lap Top PC, ar can he

] 0 downloaded from the Correlating Pode ata

SaVE .ea later time. Furthermaore the collected data
,f @a‘-' can he re-analysed from the files stored on

Save After Each Stage Giand Close o the PC's hard drive ar file server with

S <o alternative filter settings and correlation
processors ifrequired.

Getting Started

This help bar may be increased in size by
\Westend Rd dragging its left side, or made full size with
—aRd || |the maximize hutton.
< > It may be remaved from the display with its
~ || |Close button, or via the iew' Menu optian
% @@ A . . . . The View' menu may also ba used to
display the bar afterit has been removed.
Pipe Jain Text Comment 723 et 726 37T ~|| |The initial state ofthe help bar may be
confiqured in the ‘Startup’ options, found on - %
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Pipe Layout Toolbar

%@ 6 A~ 8 8 8 8

Pipe Jain T et Cormrmnent 723 3725 726 727

The pipe layout toolbar at the bottom of the pipe layout area shows Pipe, Join, Text
Comment and the serial of each logger used.

Putting loggers on the map

Start by selecting a logger and with the mouse button held down drag and drop it from the
toolbar onto the pipe layout area. It is not important to place the loggers precisely as the
software pays no attention to position on the screen. The most important data is pipe
length and material type which is entered later.

™ Radcom SoundSens - [Pipe Layout] L Fz
x

FJ File Comms Correlation Wew Tools Window Help k.

O | W@ | & 4088 | X4 &= Y

e Soundsens  *
0O New | Search ,—
,vﬁs Topics ] Search Results |

Introduction ”~
= Open Getting Started

‘wizard Bar

Connecting the Hardware

1 Configuring a Recording »

Recording Setup
”ﬂ ;a Introduction 5

2 Create Pipe Layout SoundSens is a powerful software package
used with SoundSens CP (Carrelation Pod)
Loggers to identify the presence of leaks in
pipe wark and determine the actual position
3 Download nfthose leaks using correlation technigues
The Leak noise data is stared by the

SoundSens software onto the PC's internal
Hard Drive ar can be stored across a

4 Correlate retwork to a File Server.
'ﬂ\ ﬁ' 'ﬁ Correlation analysis can be underaken 'On
=ite'with a Lap Top PC, or can bhe
| downloaded fram the Correlating Pods at a
Save later time. Furthermaore the collected data
can be re-analysed from the files stored an
Save After Each Stage the PC's hard drive orfile serverwith

alternative filter settings and correlation
processars if required.

2 & Getting Started

This help bar may be increased in size by
dragging its left side, or made full size with

¥ | [the maximise button.
£ b3 It may he removed fram the display with its
Close hutton, or via the View' Menu option.
% &@ A The iew' menu may also be used to
: . display the bar after it has been remaoved
Fipe Join Text Comment The initial state ofthe help bar may be
configured in the 'Stadun’ options, found on -

Putting joins on the map

To add a join on the map click once on Join and then click once on each place that
you need a join. Only use a join for a change in pipe direction, or pipe material.

@ ey A 8 8 8 8

Pipe Jain Text Cormment 3723 725 726 7
REMEMBER TO SAVE REGULARLY (PAGE 8)
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Putting text comments on the map

To add a text comment click Text Comment and then click on the map where you wish to
see a text comment.

%@@llll

Pipe Jain 3743 75 3726 kRer

B Pipe Layout

s
Text Comment
Hello world oK
Cancel |
@ %rientatun Haorizartal j
Harizantal i~
Wertical [307] &
Wertical [270%)
G
Er b
)
< | »
S Be /A
Pipe Join Text Comment
Place Text Comment -

Type your text comment here, and pick a text direction, then click OK
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Adding connecting pipe work to the map

After dragging and dropping the loggers onto the pipe layout area and adding the join
points you can start adding the connecting pipes.

%66 A~ B 8 8 B8

Fipe Jain Text Comment v ar2h are vy
Click the pipe icon once and then move the mouse pointer over one of the loggers. Click
and hold the mouse button down over the first logger and then move the mouse to the
logger you wish to connect it to.

]

1w d & % B YN 4 =LY

‘wizard Bar ﬂ %3 ’%iﬁ| @/| 3.‘&| Soundsens Eﬂ
D NBW A Search: ’—

@ —| Topics ] Search Results |
= Open |ntroduction ~

Getting Started

‘wizard Bar

Connecting the Hardware
Configuring a Recarding »

1 Recording Setup

Pipe Properties... [g| Introduction A

2 Create Pipe Layout [v Select fram materials database SoundSens is a powerful software package
used with SoundSens CP {Caorrelation Pod)
M aterial: |PVC j Loggers to identify the presence of leaks in

pipe work and determine the actual position

3 Download Length: 1000.00 Metres ofthose leaks using correlation techniques.

The Leak noise data is stared by the
SoundSens software onto the PC's intermal

. SoundVelocity:  [B60.00 mirs/sec Hard Drive ar can be stored across a

4 Correlate Networkto a File Server.

Diarneter: 1 2mrm = Correlation analysis can be undertaken 'On
m @ site'with a Lap Top PG, orcan he

Cancel downloaded from the Correlating Pods at a

later time. Furthermore the collected data
can he re-analysed fram the files stared on
the FC's hard drive ar file serverwith
alternative filter settings and correlation
processors if required

Save

Save After Each Stage

@, ﬁ Getting Started

This help bar may be increased in size by
dragging its 1eft side, ar made full size with
|| |the maximise buttan

< | b3 It may be removed from the display with its
~ ~ Close button, orvia the View' Menu option.
% @@ A The “iew' menu may also be used to
. . display the bar after it has been removed.
Fipe Join Tet Comment The initial state ofthe help bar may be
Place Fipe confiqured in the 'Startup’ options, found on ™

Pipe Properties...

X

I+ Select fram materials database

Material: |F"-"'|: j
Enter the pipe length

Length: |1 000.00 Metres

SoundVelasiy |EED_DD —— 2 Select the pipe diameter
— from the drop down menu

Diarneter: 12mm -/

Click OK

DK I LSt e | ] I 1
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Changing Properties on Pipe Layout

-] Pipe Layout E”E”‘s__q
el 2| ny

Remove 3

17000 m

Make Survey Sweep

Right click on the pipe you want to eor
change and select Pipe Properties
from the menu.

s

Edit Pipe Layout Id's...

Pipe Properties. ..

Disable Pipe

100.00m

lu 50.00
150.00 m

Fipe Join Text Comment

‘%@@A

Pipe Properties... rg| Change the pipe material here
v Select fram materials databaze /
/ -
Materiak | PvC =l / Change the pipe length here
| __——

Length: |1 000.00 Metres  ——

Change the pipe diameter

Sound Velociy: |BE0.00 mirs/sec | ___—— from the drop down menu here
/_/I
Diameter: 12mm -

Click OK to keep the changes
| Ok 1&&9' | or Cancel to leave unchanged.

.

REMEMBER TO SAVE REGULARLY (PAGE 8)
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Download loggers

The loggers can be collected when the recordings have finished.

If you leave the SoundSens software running then you will see the following information to
help you tell when the recordings are being done, and when they are finished.

00:00:36 (5) «—— Time shows how long until the recording
g starts. The number in brackets shows how
(®) SoundSens

many recordings are left to do.

When is says No Scheduled Recordings it

: means all the recordings have been finished.
F’% SoundSens The SoundSens software must be left running
- bt for this to work. If the software is stopped
then the counter will reset back to showing No
Scheduled Recordings.

Note : When the loggers are put back in the case for downloading they can go back in any
order.

wizard Bar ﬂ
o N With the SoundSens software running and the USB cable
ew connected between the laptop and the suitcase click the
Download button.
5 Open >

Downloading All Becordings
[Recarding Set 1, Suitcasze 1, Position 1, 3731)

1 Recording Setup

Eztimated Time Remaining: 1 min 32 sec

SoundSens

Z Create Pipe Layout

\gp\-[ﬂvnloml
I Loggers Will Be Excluded

4| If any fail to communicate you
will see this error message.

L
\E) Download Completed Successfully,

'T The following loggers will be excluded beacuse they have no recorded data:

v

3731

Save
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Downloading Loggers (Multiple Suitcases)

Connect the suitcases together as shown in the section “Information regarding daisy
chaining multiple cases together”

Connect the USB cable to the first suitcase.
Click the Download button.

The software will ask for conformation about the number of cases. If this number is
incorrect ensure the USB cable is connected to the first suitcase, and that all the cases are
connected together correctly.

If the number of cases is correct then the download can begin. After each box of loggers
has been downloaded the software will ask for the USB cable to be moved to the next box
in the line. This process will be repeated until all the connected boxes have been
downloaded.
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Correlation

After the data has been downloaded correlation begins automatically.

8 Radcom SoundSens - barrack road 3.ssd El@lgl

File Comms Correlation Wiew Tools Window Help

0 & | WJ| & € 4888 & |4 & [[Y
WizardBar ﬂ

22 Exhaustive Correlation - High Resolution |Z||§|r>__<| mh—g@g

D NE.'W i] g] |I& Distance Domain éé,f Ei% §ﬁ| @/| %|

Correlation | Average [ (1) Jan 22 2001, 02:30:048M |(2) Jan 22 200
= Open 10260 m 855

292 © q426m 298 (1)88.E%

149.90 m . 57 5% -L

1 Recording Setup 284 1gzgm 301 (1187.1%

‘ 9360 m ‘ a71%

—

295 4fsam 301 (10868%
2 Create Pipe Layout & T08%

284 sooam 208 OTT% e B sl "

8 43.20 m 8 a7
CEE—
292 .60 m 301 (11E9.5%

3 Download

4 Comelate

Save

Save After Each Stage

e A

Jain Text Commert

A5 wWindok  HElp

. | '1;'1 |ﬁ 3 |[34 4 Comelate
ad

To begin the correlation process manually after opening a data file click the Perform
Correlation button, or click Correlate on the left menu bar.
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E% Exhaustive Correlation - High Resolution

After correlation has finished

%] | 2] | 4 Distance Domain =]

| the software sorts the data.

Correlation | Average | (1) 3an 22 2001, 02:30:04AM [ (2) Jan 22 2001, 02:45:04AM [ (3) Jan 22 2001, 03:00:04AM

Lot o The most likely leak
292 7 142m 2?3 (1) 68 & l. L L . y

LRty 7 L L 1 correlations will be at the top.
294 118.29m a1 (1E71%

9360 m a7 1% J J 1
2898 4039m 3ot (1) BE.9%

3,70 m 70.8%
B4 pooam e NTITH pani b mﬁL dide Nt .ll..mu__mmk

48.20 m B9.7% JM
22 © geom  om (0639% k0 I .LJ.AA!‘M i ebes bl A Ll

Done

B Pipe Layout |Z”E‘E‘

| & The location of each possible
~| leak is marked on the map
| by red markers.
By 2P m ¥ 603 70.00 ™ “@
& L9 Y ry f
L[| > 5
Qe Be A
Fipe Join Text Comment
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Click once on the recording graph and the blue circles will indicate which two loggers
have been correlated between.
A third smaller blue circle will show the possible leak location.

& Radcom SoundSens - barrack road 3.ssd

File Comms Correlation Wiew Tools ‘Window Help

0= | | & & %588 4 [y

‘wizard Bar

:_E'Exhaustive Correlation - High Resolution

O NEW ﬂ ﬁ “& Digtance Domain j

Correlation | average [(1y 2an 22 2001, 02:30:048m (2) Jan 22 2001, DZ:45:04AM | ¢33 33n 22 2001, 03:00:04pm
10260 m 58 %
292 © 1426m 209 (1)838% . s e
. 143.90 m . 57 E%
=T
1 Recording Setup 28 nzzem 301 (NETA%
. 93.60 m ‘ 87T1% /
98 sdzam 301 (186.9%

2 Create Pipe Layout S3.70m T08%

—
294 &0.03 m 258

g B Pipe Layout

4520 m ‘ EZ.7% |Z”E|E‘ I
3 Download 22 ° geum 301 A6 bl e arre| Tt e
G |28 Aﬁﬁ| @/| E&é
~
4 Conelate N
Sav

Save After Ead]

Click once on recording

graph. T @ W v
Loggers circled. 3

WOgEL

|

Possible leak location 3 =
A

Jain Teut Comment

292 -» 298 = 83.8% , 14.26 Metres

Double click on the recording graph to see a close up view.

2% Correlation ( 292 - 298 ) (=13
[Famzom eanen <] O ([~ 88888 se/ieof x|
(=N Jan 22 2001, 02:30:044M
14.28 :ﬁiares
@
h=3
=
E—
)
=
=
™
o
LENYS " A ah.
0.000 20000 40000 B0.000 &0.000 100.000
Cursar: . "
| 102.60m [1254.01 mirsfzec) »
0e% e = =l
292 142Em 88.34m Togs
. Distance Time [Real] | Time [Absolute] |  Coherence Sampled Data | Auto-Spectium
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The Basic Recording Graph

Two logger serial
numbers between
which correlation has
taken place

(Logger 1 > Logger 2)

Leak location shown as distance from logger 1.

&% Correlation [ 292 -> 298 )

EBX

|1-Jan 22 2001, 02 30.048M |

KPP AP AR LY UK P9

1 Jan 22 2001, DZ:SD:D4AM/

it}
=
=
=
?
w
E
=
=
O
[

14.25@1%&3

Distance between loggers
Sound velocity shown in brackets

Al

0.0o0
Cursar:

40000 ¢ 50.000 100.000

(™
82.5% Mle

10260m (1254.01 mtrafsec)

0

G534 m

Distance

Logger 1

Time [&bzolute]|  Coherence Sampled Data TN

Leak distance from logger 1 and logger 2
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Recording Graph Advance Features

Zoom functions

_AREIEL

Zoom X — Zoom Y — Zoom XY — Zoom Out One Step — Zoom Out Fully

Listen to recordings from loggers

Je,|def| € X |
_— /1

Left logger — Both loggers — Right logger — Stop playback

Graph viewing options

1-Jan 22 2001, 0230.048M = | %| 1 ]
4

2-Jan 22 2001, 02.45.048M \
| )

This drop down menu
reduces the number of
graphs on the screen.

If two or more graphs are being
viewed this drop down menu

selects which one is on top. :
P If two or more graphs are being

viewed this button cycles
through them putting each one
on top in turn.
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Reveal Advanced Graph Options

—LF=E0r;

0. 0% lh—

X Diztance

Click the small up arrow on the bottom left of the graph to reveal the advance graph
options (see below)

| ag  14.2om .4 M
¥| | Distance | Time[Real] ]Time[Absolute]]| Coherence | Sampled Data | Auto-Spectum |
Correlatian Band Fazz Filter [Hz]

292 v 298 | Upper 1000
|Jan 222001, 02:30:044M j Loweer: |EI Apply |

Carrelation

Logger 1 > 1 Logger 2
Serial number |EEIE ﬂ |EE|E il Serial number

\Jan 222000, 02:30:048M |

K

To see the correlation graph between two different loggers just change the serial numbers
shown in the drop down menus for logger 1 and logger 2, and then click Apply.

Date and time of recording

To superimpose another recording taken between the same two loggers over the existing
graph, select it from the time and date drop down menu and then click Apply.

To change the Band Pass Filter, adjust the figures and then click Apply.
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SoundSens Software Advanced Configuration

1 IE! Window  Help

Cipkions. ..

Import, ..

Export. ..

Impork Pipe Layout...
Export Pipe Layout. ..
Edit Pipe Lawvout Id's...

— L

The General tab

Software start up options.
These changes will take effect next time the software is started.

Wizard bar

hand side of the screen

The blue bar found on the left

;
i

tartup

Software Mode
&+ Mormal

" Advanced

General - Configure the startup appearance and operation of
zoftware mode and meazurement units tupe, Set the pipe

General lEommunications Recording Defaultsl Fipe Mayout | Corelation | Exhaustive Eorrelatinn] GAL*

¥ Dizplay ‘Wizard Bar

™ Reload last workspace

™ Automatically S ave Document after major operations

Ticking this box
makes the software
auto save your work

base:

From the Tools menu click Options.

This is intended as a general guide
to the SoundSens software options.
For further assistance and
explanation please contact the
HWM technical support team.

Help bar
Found on the right hand side
of the screen

undsens. Select the A

enials databaze path ﬂ

¥ Dizplay Help Bar

¥ Maximize

teasurement Units
&+ Metric

" Imperial

|I::'\F'lc-glam Filez'R adcom TechnologieshS ou

Ticking this box
makes the software fill
the screen when it is
started

|I::'\My DocumentghSoundSens
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The General tab (continued)

Options...

i

'r General - Configure the startup appearance and operation of Soundzens. Select the A
¥ . ! :
software mode and measurement units type. Set the pipe material: database path Cancel

Start the SoundSens software in Advanced or

General | Commmic sticns | Bacading Daiauls | Bina | sy | rgrre|ati.:,n] Bel e Enrrelatinn] GA|r

Normal mode. _ _ tar | Change the measurement units
In Advanced mode you will see optlons.such as between metric and imperial
those seen at the bottom of the correlation graph
[ Automatically SAve Document after major operations
Software Mode teazurement Units
f* Marmal &+ Metric
" Advanced " Imperial
Pipe Materials Database: |E:'\F'n:|gram FilezhR adzom TechhologieshSoundS
Cefault Open Path |E:'xh-1_l,l DocumentshSoundSens
The default location

The location of the pipe
materials database

SoundSens i User Guide
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The Communications tab

Options...

: Communications - Select the cormm port o uge ta connect the soundens suitcase o A
f—— the PC. ze 'Help - Find Awvailable Parts' for maore infarmation on available portz.

b Cancel |

l R ecording Defaults] Fipe La_l,u:uut] Eu:urrelatiu:un] E shaustive Eu:urrelatiu:un] GA|r

Sensar Type | Praduction Senzor 1 f

Part: | COr5

Set the default sensor

(logger) type

[+ Monitor USE Paorts. Prompt when USE device CDHW

Synchronization Caonfirmation

[v Prompt on detailed setup

Set the default

communication port

| Prampt on quick setup

Help - Find Available Portz...

SoundSens i User Guide
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The Recording Defaults tab

The default recording options.

Change the Notch filter value for filtering out
mains frequency interference. This is set when
the software is installed, but can be changed
here (for UK it should be set to 50HZz)

Options...

Match Filter B0Hz | Low Pass Fiter High =l
Default Recording Durations
1, |S mall Diarneter Metal |1 0 Seconds
2 |Large Diameter kietal |2|:| Seconds
3 |F'Iasti|: |3EI Seconds
4. |L| ser Defined |E|:| Seconds

; Recording Defaults - Select the Motch filter setting [mainz power frequency] and the

i default recording configurations for use with quick recarding setup
B - Cancel

General] Communications | Becording Defauls l Fipe La_l,u:uut] Eu:urrelatiu:un] Exhaustive I:::urrelaticun] G4

These are the default recording durations for
selected pipe materials. You can change them
to suit your area. For further information please
contact the HWM technical support team.
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The Pipe Layout tab

The pipe layout area options

Options...

Cancel |

'r Pipe Layout - Enter grid values to set the precision of items placed an the lapout,
] : ' :
= and the survey sweep configuration. Survey sweep can be uzed to automaticaly

||

Fipe Layout Grid Survey Sweep

Layout
# Units (10 [ Automatically Build o Lihe

Y Urits (10 Pipe Defaults | " Star

Frinter Settings

i ; v Multiple path warni
" Fittopage FullSize ultiple path warnings

Fipe Material Pipe Colour -~

Asbestos Cement:

Cast Iran e

Copper ¢ >

Concrete L y | [
/

To change the colour of the pipes on the pipe
layout double click on the coloured area.

Select a new colour from the menu which pops
up on the screen, and then click OK Edit Pipe Colour

X

Select the required pipe colour From the list and
select OK, or double click the required colour,

Cast Iran

|

Cancel
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The Correlation tab

By default only one peak will be Mid peak suppression

highlighted with it's value If the logger hears nothing then it
displayed on the graph. You can may put a large peak in the centre of
change this to a higher number if the correlation graph. This option will
preferred. prevent it from happening

Options...

; Correlation - Configures howl peak.:s should be detected and displayed. The nimber
e of peaks to highlight, or a pefcentage confidence may be set [all peaks above this
s Cancel |
General] Eummunicatiuns] Recording
Peak Detection Feak Suppreszsion
' Mumber of Peaks 1 [v Mid-peak Suppression .01
" Percentage Threzhaold % Feak Width [zecsl  |0.01
Leak Location Markers Out af Brackets Markers
[v Confidence Colours [v Distance from logger Colours
from  |g& El: % Marker e |5 El: % Markern |
to 100 3: %  Background: Backgroun |
[ Dizplay Threzhold on Graph
Leak Marker Optimization Default Comelation Graph type
[ Optimise leak markers within: 1 Metres "& Distance Dumaiy j
/ /
/ /

Change the default colours of your leak
location and out of bracket markers here.
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The Exhaustive Correlation tab

The default option here is All Recordings. This will perform correlation using all
the recordings in the loggers.

Use Pop-up Significant Correlations to automatically display the graph or graphs
for locations most likely to have leaks.

Options...

E shaustive Correlation
[v Al Becardings

'r Exhaustive Correlation - Sélect 'l Becordings' to correlate all logger recardings. PN
¥ ) S T : ; . .

T— Fop-up Significant Corrflations will automatically dizplay detailed corelabion graphs o,

R Cancel

General] Communications / Recording Defaults] Pipe Layout | Corelation ;| Exhaustive Correlation l E | "|

| Pop-up Significant Corelations
[ &l Logger Pairs if Fipe Layout
[ &l Logger Pairs if Survey Sweep

N

The "All Logger Pairs' options specify whether to
correlate every logger with every other logger in
the layout, or perform sufficient correlations to
ensure full pipe network coverage. By default,
these boxes are not ticked.

Exhaustive correlation using 'All Logger Pairs' may
take significantly longer on a large pipe network.
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The Graph Colours tab

To access the tabs past Exhaustive Correlation you need to click the right hand arrow as

indicated on this diagram

Lancel

, | Exhaushive Comelation l G 4@

SoundSens i User Guide

Leak Localisation and correlation

Configures the styles and colours used to display
data graphs as well as fonts for axis and graph text.
Select Defaults to return to the default settings.

Options...

o EE |

A
AR

araph Colours)Styles

Graph Ling 1... | _

Graph Ling 2... _
Graph Ling 3... _
Graph Line 4... _

Graph Ling 5. .. V\

l:

Graph Colours - Configures the sples and colours used to display data araphis, and
fonts for awiz and graph text. Select Defaults to return to the default zettings.

l Graph Options ]

Background. .. | |

Ais... | —
Garid Lines. .. |
Lirnit Lines. .. | | _—
-

current Gra | Enable Style Change

Graph Ling &. .. _— Skyle, .. | -
Graph Line 7...
SRy Gl [ Enable Style Change
Graph Line &... Skyle...
Defaulks. .. Axis Font ¢arial) Font {Arial)
N\ N
N\ N\

Graph Line 1

Select the colour and/or style for the graph item. Gradie

graph background, and create a shaded background in the current graphs colour,

Select a new line colour and

Sample |

Select Colour Select Style
EEEEREN | —
aEREN | || —

- — -

style, and then click OK

B |_ |_ ........ —

Cancel |
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The Graph Options tab

Configures the functionality of the graph.

Options...

'! [araph Optiohz - Configures the functionality of the graph.
[
Cancel
...................................... s

Graph Cptions

Cursor Line

Grid

Display Peak Position as Text Yalue on Graph
[ auto Scale Graph Text with Graph Size
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Troubleshooting

Carry Case Not Communicating with PC or Laptop

Using Serial (RS232) Cable

Check the communications port. Change the communications port number by
Tool -> Options -> Communications tab clicking the drop-down menu and selecting a
different one.

; Communications - Select the comm port to use to connect the soundens suitcaseto A~ -1
g—=1 the PC. Use Help - Find Avaiable Parts' for mare information on available parts. T Cancel

-

Senzor Type |Production Senzar lll :J
Port: |- COMS [~

¥ Moritor USE Ports. Prompt when USBE device connection chisnges

Sunchronization Confirmation
[¥ Prompt on detalled setup

[ Prompt on quick setup

Help - Find Awailable Ports...

Incorrect Sensor Type

SoundSens Error

If the wrong sensor type is selected you may see an

During download the Following errors occurred: error durlng communication.
Mo Loggers Connecked

The options are

Change the sensor type from the drop down menu

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor Il (Otherwise known as SoundSens i)
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Change Sensor Type

From the Tools menu click Options

Click the Communications tab

The currently selected sensor
is shown here

To change the sensor type
follow the next instruction

e

1 IE! Window  Help

Import...
Export...
Import Pipe Lavouk. ..
Export Pipe Lavout. ..
Edit Pipe Layout Id's, ..

— e L

Options...

General - Configure the startup appearance and operation of Soundsens. Select the
zoftware mode and measurement units type. Set the pipe materials database path -, Cancel

General 1# ecording Defaults] Fipe Layout] Correlation] Exhaustive Conelation] GAlr
Tl
v Display \Wizard Bar

[™ Reload last workspace

I Dizplay Help Bar

[¥ M aximize

[~ Automatically 5ave Document after major operations

Saoftware Mode Meazurement Units
&+ Momal * Metric

" Advanced " Imperial

Pipe Materials Database: |E: “Program FilesRadecom TechnalogieshSoundS

Default Open Path |C: ‘W DocumentshS oundSens

Options...

Communications - Select the comm part to uze to connect the soundens sultcasze to &
the PC. Uze 'Help - Find Awailable Ports' for maore information on available ports. P Cancel

General Recording Defaults] Pipe La_l,lout] Conelation] E shaustive Conelation] GAlr

Salpe >

Part: | COME j

| Production Sensar [

[v Manitor USE Parts. Prompt when USE device connection changes

Synchronization Confirmation
IV Prompt on detailed setup
[ Prompt on quick setup

Help - Find Available Parts...
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Options...

; Communications - Select the comm port to use to connect the soundens sultcasze to A~
| the PC. Uze 'Help - Find Avwvailable Portz' for more infarmation on available ports. = Cancel

General Communications ] Fecording Defaults | Pipe La_l,lout] Correlation] Eshaustive Conelation] GAlr

Sengar Type | Production Senzar (Il j

Pre-Production Sensor —LI
Production Sensor
Production Sensor ||

Port:

[ toritar USE Parts.

Synchronigation Confirmation
[ Prompt on detailed setup
I~ Prompt on quick sstup

. Click the drop down menu and
click on the type of sensor you
have.

Help - Find Available Parts. ..

The options are

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor Ill (Otherwise known as SoundSens i)

Options...

; Communications - Select the comm port to uze to connect the soundens sultcaze to &
£==1 the FC. Use Help - Find Avaiable Ports' for more infarmation on available ports. P Cancel

General  Communications l Recording Defaults | Pipe Lavout Correlation] Exhaustive Conelation] GA|*

Senszar Type Productio E0
Pt |- comn |

[v Maritar USE Partz, Prompt when USE device connection changes

After making your selection click
OK to save the change.

Synchronization Caonfirmation
[V Prompt on detailed setup
[~ Prompt on quick setup

Help - Find Available Ports. .
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SoundSens Software

License Agreement

Carefully read all the terms and conditions of this agreement prior to using this SoundSens Software. By attempting to load the Software
you indicate your acceptance of these terms and conditions.

License: You have the non-exclusive right to use the enclosed Program on a single CPU. You may physically transfer the Program from
one CPU to another provided that only the licensed company uses the Program. You may not distribute copies of the Program or related
documentation to others. You may not modify or translate the Program or related documentation without the prior written consent of
HWM-Water. You may not use, copy, modify or transfer the Program or documentation, or any copy thereof, or permit anyone else to do
S0, except as expressly provided in this agreement.

Back-up and Transfer: You may make one (1) copy of the Program solely for your own back-up purposes. You must reproduce and
include the copyright notice on the back-up copy. Transfer of Program and license to another party may only be made after written
approval from HWM-Water, provided the other party agrees to the terms and conditions of this agreement and completes and returns a
Product Registration Form to HWM-Water. If you transfer the Program you must at the same time transfer the documentation and back-
up copies or transfer the documentation and destroy the back-up copies.

Copyright: The Program and its related documentation are copyrighted. You may not copy the Program or its documentation except for
your own back-up purposes and to load the Program into the computer as part of executing the Program. All other copies of the
Program and its documentation are in violation of this Agreement.

Terms: This license is effective until terminated. You may terminate it by destroying the Program and documentation and all copies
thereof. The license will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such
termination to destroy all copies of the Program and documentation.

Warranty: HWM-Water warrants to the original licensee that the diskettes on which the Program is recorded be free from defects in
materials and workmanship under normal use and service for a period of 90 days from the date of delivery to you as evidence by a copy
of your invoice. During this period HWM-Water warrants that each program, which is designated by HWM-Water, as warranted in its
program specifications, supplied with the program, will conform to such specifications provided that the program is properly used on the
machine for which it was designed. If you believe that there is a defect in a warranted program such that it does not meet its
specifications, you should notify HWM-Water within the warranty period (the warranty period may be extended by signing a software
update agreement with HWM-Water) in a manner set forth in the program specification.

All back up copies are provided “as is” without warranty of any kind, either express or implied. The entire risk as to quality and
performance of the Program is with you. Should the Program prove defective, you assume the entire cost of all necessary servicing,
repair or correction. HWM-Water does not warrant that the functions contained in any program will meet your requirements or that the
operation of the Program will be uninterrupted or error-free or that the programs defects will be corrected.

The foregoing warranties are in lieu of all other warranties, express or implied, including but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. HWM-Water is not responsible for problems caused by changes made after the
publication of the software in the operating characteristics of the computer hardware, test instruments or operating systems, nor for
problems in the interaction of the Program with non-HWM-Water software components.

Limitation of Remedies: HWM-Water’s entire liability and your exclusive remedy shall be as follows:

a. With respect to defective media during the warranty period, HWM-Water will replace media not meeting HWM-Water’s

“limited warranty”, if returned to HWM-Water with a copy of your receipt.

b. With respect to warranted programs, in all situations involving performance or non-performance during the warranty

period, your remedy is (1) the correction or bypass by HWM-Water of program defects or (2) if, after repeated efforts,

HWM-Water is unable to make the Program operate as warranted, you shall be entitled to a refund of the money paid.

In no event will HWM-Water be liable to you for any lost profits, lost saving or other incidental or consequential damages arising out of
the inability to use any program even if HWM-Water have been advised of the possibility of such damages, or for any claim by any other
party.

Update Policy: In order to be able to obtain updates of the Program during the warranty period, the licensee and persons to whom the
Program is transferred in accordance with this agreement must complete and return the attached User Registration Form to HWM-
Water. If this registration form has not been received by HWM-Water, HWM-Water is under no obligation to make available to you any
updates.

Miscellaneous: This license agreement shall be governed by the laws of England and shall inure to the benefit of HWM-Water, its
assigns and successors.

Acknowledgement: You acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and
conditions. You also agree that this agreement is the complete and exclusive statement between the parties and supersedes all
proposals or prior agreements, verbal or written, and any other communications between the parties relating to the subject matter of this
agreement.

Should you have any questions concerning this agreement, please contact HWM-Water in writing at the relevant address:

HWM-Water Ltd.

Ty Coch House
Llantarnam Park Way
Cwmbran

NP44 3AW

United Kingdom

Tel: +44 (0)1633 489479
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Installation Instructions

I e
( =

' SoundSens . IUSE Drivers . .
‘.J ‘.J Put the CD in your PC drive, and
: double click the “installer” icon
T4 AUTORUN »
= Setup Information | In=tafer
| KE installer
mainlogol reqisker
160 x 119
Bitrmap Image

Texk Document
EX Radcom Software Installer [?|

1kE
m | The Radcom Software Installer

window will pop up. Click the
SoundSens button.

Z Application

SoundSens w321 A

Fiadcom [Technologies] Lid.
Sentry House B
10 Romszey Industrial Park
Greatbridge Foad

Fiomzey

Hampzhire v

Copyright © 2005 Badcom Technologies Ltd

SoundSens - InstallShield Wizard

When the Installation Wizard
begins click Next to continue.

Welcome to the InstallShield Wizard for SoundSens

i camputer To oo

InstallShield < Back (Hents Caricel

SoundSens i User Guide
Page 60 of 64



SoundSens i User Guide
Leak Localisation and correlation

SoundSens - InstallShield Wizard

License Agreement
Pl a

Agree to the license, and then click
next.

RADCOM [TECHMOLOGIES] LIMITED LICENCE AGREEMENT

Carefully read all the terms and conditions of this agreement prior to using this RADLOG
Software. By breaking the media seal pou indicate your acceptance of these terms and
conditions.

Licence: ‘Tou have the non-exclusive right to use the enclosed Program on a single CPU

“r'ou may physically transfer the Program from one CPU to another provided that the Program is
uzed only by the licensed company. You may not distibute copies of the Program or related
documentation to others. “f'ou may not modify or ianzlate the Program or related
documentation without the prior written consent of Radcom. You may not use, copy, modify or
transfer the Program or docurmentation, or any copy thereaf, o permit anyone else to do o,
except a3 expressly provided in this agreement.

Back-up and Transter: You may make one (1] copy of the Program solely for pour own

back-up purpozes. Y'ou must repraduce and include the copyright natice on the back-up

copy. Transfer of Program and licence ta anather party may only be made after written

approval fram Radcom, provided the other party agrees to the terms and conditions of this
agreement and completes and returns a Product Registration Form to Radcom. If you transfer

the Pragram you must at the same time transfer the documentation and back-up copies or
sfal the documentation and destroy the back-up copies. v

IrstallShield < Back Nest > Cancel

SoundSens - InstallShield Wizard

Choose Destination Location

If you wish to change the location
of the installed files you may do so
here. Click next to continue.

Irastarll Shiield < Back Nest > Cancel

SoundSens - InstallShield Wizard

Ready to Install the Program
The wizard i i

Click install to continue.

InstaallShield <Back ; Cancel
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Select notch filter value for
electrical noise rejection. By
default 50Hz is selected for the
United Kingdom. Then click next.

(this option can be changed from
within the software after
installation.

Tools -> Options -> Pipe Layout)

InnstallShield <Back H et > Cancel

SoundSens - InstallShield Wizard
Click Finish to complete the
installation.

InstallS hield Wizard Complete

Setup has fi

InstallSHield | cBesk | Pk | caca |

EX Radcom Software Installer,

SoundSens Finally close the Radcom Software
Installer.

Please now follow the USB
driver instructions.

SoundSens w321 ~

Radcom [Technologies] Lid.
Sentry House B
10 Romszey Industrial Park
Greatbrdge Road

Fiomzey

Hampszhire v

Copyright © 2005 Radcom Technolagiss Ltd

SoundSens i User Guide
Page 62 of 64



w SoundSens i User Guide

Leak Localisation and correlation

USB Driver Installation Instructions

If you are installing the SoundSens software on a PC which has never had a USB
SoundSens i case connected to it, you should install the USB driver.

C aourons From the installation CD double click the
',,J { “USB Drivers” folder.

—f"-"'-‘"" ) gUtTOF;UPl ki : installer

E 1EKEID nirormaten (o] installer MFC Application

mainlogol = register
160x 119 == | TextDacument
Bitrnap Imnage = 1EKE

. setup
Caonfiguration Settings

dsbbus Double click the “Prelnstaller”’ icon.

System file
S5 KB

= o,
Ld = Readme
e:—‘] Prelnstaler - ==| TextDocument
o i FreInstaller MFC Application ==
™ =_| 2k

slabbus e , slabbus
Security Catalog = Setup Information
10KE 9B

slabem®s slabcmnt p slaboomm, vxd
Systen file Syster file e | virtual device driver
11KB BKE 24 KB

slabser
System file
BB KE

slaber slabser
Systen file Security Catalog
4KB 9B
ase | slabuninzk
slabunin windows Setup APT
windows (R) 2000 DDK provider
slabunin.u9d P slabrved.wxd p slaber vxd
28 File "-5, virtual device driver '-5 Wirbual device driver
LKE 13KB 30KE

. slabwxd e . slabwzk ) . slabwdm
Setup Information = Setup Information E Setup Information
11KB SKE SKEB

slabwh3as
Systen file
FKB

slabunin.uzk
LIZK File
1KB

slabwhnt
Syster file
BKE

<& Install Driver

Click Install to “install” the driver.
CP210x USE to UART Bridge Contraller Driver Set

C:A\Program FilestSiLabs\MCUACP21 0% Brawse

Carcel |

Prelnstaller;

R The Prelnstaller program will display this message if the driver
\!‘) Installation Successful | installs correctly. Click OK to continue.
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HWM-Water Ltd.

Ty Coch House
Llantarnam Park Way
Cwmbran

NP44 3AW

United Kingdom

+44 (0)1633 489479
www.hwmglobal.com

©HWM-Water Limited. This document is the property of HWM-Water Ltd. and must not be copied or disclosed to a third
party without the permission of the company. All images, text and designs are protected by international and UK
copywrite law and remain the property of HWM-Water. It is against the law to copy or use any of the content from the
HWM website or literature without the written consent of HWM-Water. HWM-Water Ltd reserve the right to vary the
specification.
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